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Introduction

What is PrintShop Mail?

PrintShop Mail is an easy to use, stand-alone authoring tool for

variable data printing. Variable printing is the unique capability of true

digital color presses to vary each impression during the printing

process.

PrintShop Mail runs on Power Macintosh™ and is designed for

producing variable data jobs to be printed using any modern printer.

Specific printing technologies are supported, to allow reaching

maximum printing speed. Basically, PrintShop Mail uses the technique

(that is part of the PostScript printer language) of separating the fixed

portion of a document (which is sent to the printer and rasterized only

once) from the variable page elements. The variable and the fixed data

or masterpages are merged when printing personalized copies of the

document.

PrintShop Mail allows you to create and print all different kinds of

variable data printing applications varying from simple mail mergers to

complex personalized documents. It is possible to vary any kind of

data: colored text, graphics and even images starting from a database

and any standard desktop prepress application. Powerful text and

graphic formatting, intuitive database linking features or conditional

formatting tools are at the designer’s disposal to generate professional

variable data printing jobs. These jobs can be saved and archived in

the PrintShop Mail native format.
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PrintShop Mail Workflow
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PrintShop Mail document
6 Introduction



1 Create the document layout in your favorite page editor. Include

only the static parts of the document and save these as images in

one of the supported image formats.

2 Images to be used in the mailing. These should be stored in the

same directory and in one of the supported image formats.

3 Database with address data for the mailing. You may use an exist-

ing database or create one for the mailing.

4 Create a PrintShop Mail document and place the static images.

Add text objects for the inclusion of variable text, such as the

address and the opening line.

5 Create a picture object and define which images should be

printed on each personalized copy of the mailing.

6 Print the mailing. The static part of the document layout is sent to

the RIP once, followed by the variable data for each of the copies

that were selected for printing.

7 The RIP creates the pages (the exact process depends on the

printing technology that is used) and sends them to the printer.

The RIP may be a physical part of the printer or run on a separate

computer.

8 The result: personalized letters with some static text and optional

static images, plus a variable texts and images, which depend on

the contents of the database that was used for the mailing.
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About this Manual

This User’s Guide is intended for professionals involved in preparing

and printing variable data jobs, such as mailings, personalized or

serialized document copies, address labels, business cards etc.

PrintShop Mail requires basic knowledge of the Macintosh™ Operating

System. 

Icons in This User’s Guide

The “Attention” icon draws attention to important information,

i.e. hints and tips, directly related to using PrintShop Mail.

If You Have Questions...

Should you have questions using PrintShop Mail, first check this

User’s Guide. The index at the back may be helpful when looking for

specific information.

If you need further assistance, contact our Customer Service

department (via e-mail: support@atlassoftware.com) or your local

distributor. Make sure you have all relevant information at hand when

doing so.
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.2
Installing PrintShop Mail

Contents of the PrintShop Mail CD-ROM

PrintShop Mail is shipped on one CD-ROM containing:

• The PrintShop Mail Installer Program containing:

• Macintosh™ version of PrintShop Mail 

• LaserWriter 8.6.5 Printer Driver

• PSMail plug-in for Adobe Acrobat

• USB driver for use with the HASP dongle

• PrintShop Mail demo jobs

• PDF version of the User’s Guide

System Requirements

The minimum requirements to run PrintShop Mail are as follows:

• PowerPC Macintosh™ with at least 64 MB of RAM

• Operating System 8.6.5 or higher - PSM has been tested on OS 9.2

• QuickTime 4.0 or higher

Requirements depending on optional software:

• Adobe Acrobat: version 4.0 or higher and 50 mb free space

• Mac OS X: a HASP USB dongle is needed. See “Using PrintShop

Mail with Mac OS X” on page 16.
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File Locations

The table below indicates which files will be installed, and where:

The Installation Procedure

The installation procedure consist of several steps, as indicated below:

(*) The hardware key (or dongle) comes with the PrintShop Mail

license. If you have not purchased a license yet, you can still install

the software and use all of its functions. The restriction in this demo

version is, that you can print only 25 personalized copies of a

document, which will have the word PrintShop Mail printed over

them. See “Credits” on page 18 for details.

Files Location

PrintShop Mail Selected folder

Examples Examples folder inside the 
selected PrintShop Mail folder

LaserWriter printer driver System folder, Extensions

ADB and USB dongle drivers System folder, Extensions

PSMail plug-in for Adobe PrintShop Mail folder

Procedure See

Installing PrintShop Mail page 11

Configuring the LaserWriter Driver page 13

Connecting the Hardware Key to Your Macintosh* page 15

Using PrintShop Mail with Mac OS X page 16

Enabling support for Adobe Acrobat page 19
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Installing PrintShop Mail

1 Put the PrintShop Mail CD-ROM in the CD-ROM drive. Double-

click on “Click Me” icon that appears on your desktop.

2 Click on the installler.

3 Click “Continue”. The installation screen appears.

The Installation window displays a list of items that can be installed:

Option Installs:

Easy Install PrintShop Mail for PowerPC 
Macintosh™, plus an example job

PrintShop Mail 
application

PrintShop Mail application only

Laserwriter driver A laserwriter driver which can be used 
by PrintShop Mail

PrintShop Mail 
Example

Example documents, with databases 
and images

Mac Link Enabler Enables importing text files

USB driver Driver to use USB dongles
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4 Select “Easy Install” to install PrintShop Mail for PowerPC Macin-

tosh™ and click “Install”. The following window pops up:

5 Select the folder in which you want to create the PrintShop Mail

folder and click “Install”. The PrintShop Mail folder is created and

the necessary files are copied. The following window pops up:

6 Click “Quit” to finish the installation process.

7 Double-click the PrintShop Mail icon in the PrintShop Mail folder

to start PrintShop Mail
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Configuring the LaserWriter Driver

1 Open the Chooser from the Apple menu.

2 Select the “LaserWriter...PSMail” driver in the left part of the

Chooser.

3 Select the PostScript Printer of your choice in the right part of the

Chooser.

4 Click the “Setup” button. The following window pops up:
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5 Click “Select PPD”. The following window pops up:

6 Select a PPD for your printer from the PPD list and click “Select”.

7 Click “OK” to return to the Chooser.
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Connecting the Hardware Key to Your Macintosh

If you need printing capabilities while using PrintShop Mail, make sure

the hardware key or dongle is connected to your keyboard, or on your

mac

To verify whether the hardware key has been installed correctly, select

“About PrintShop Mail” from the Apple menu. The software version

number and the number of available credits is displayed in the first few

lines of the copyright notice.
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Using PrintShop Mail with Mac OS X

PrintShop Mail runs in Classic mode when installed on Mac OS X.

Apart from the software, you need to install a different dongle driver

when working with Mac OS X. Make sure you have the HASP dongle.

Follow these steps to install the driver:

1 Start the “aksusb” installer, which is available in the Installers

folder on the PSMail CD. The program shows the following dialog:

2 You must enter the username “root” and supply the correct pass-

word; otherwise, the installation cannot be done. If you do not

have the root password, contact your system administrator.
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3 The installer displays the following window:

4 The drivers are installed within a couple of seconds; there is no

need to restart the Mac. 

5 You can start using PrintShop Mail and the program will automati-

cally recognize the dongle. You can check this by viewing the

credits.
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Credits

The number of credits is the number of document copies, i.e.

combinations of one database record with one personalized

document, that you can print.

If you print more than one document on a page (e.g. when

printing address labels), each document is counted as one

personalized copy. So, printing 25 address labels which fit on

one printed page will cost 25 credits. On the other hand, if you

have a document with 5 pages and you print 25 personalized

copies of that document, you will have 125 printed pages, but

this will cost only 25 credits.

For information on how to upgrade the number of credits, contact Atlas

Software or your local distributor.

You can find your available credits by choosing the 'Credit Information'

item in the 'Help'-menu. If the hardware key is missing, the 'Credit

Information' screen will display the message "Key type: Not Valid" and

"License: 25 (Demo Mode).

 credits implies

Designer mode Your Macintosh™ did not detect the PrintShop 
Mail hardware key. You can work in Designer 
mode and print 25 document copies (with 
PrintShop Mail printed over them).

xxxxx records You have xxxxx records available.

unlimited You have unlimited printing capabilities.
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Enabling support for Adobe Acrobat

PrintShop Mail allows using PDF files as the basis for personalized

documents. To enable this option, you need to have Adobe Acrobat

version 4 or higher installed. To place a PDF file into PrintShop Maill

go to File - Place PDF. When placing a PDF in a PrintShop Mail

document, Adobe Acrobat is started in the background, to interpret the

PDF and make the resulting image available to PrintShop Mail.

When Adobe Acrobat starts up, a registration dialog may be

shown. This should be avoided when the program is started

by PrintShop Mail, as it will lead to problems in PrintShop

Mail. After installing Adobe Acrobat, you should either register

the program or tell the program to not show the registration

dialog again.

PrintShop Mail uses an Adobe Acrobat plug-in to start the program

when required. When placing a PDF for the first time, PrintShop Mail

asks you to locate the Adobe Acrobat program you would like to use.

This information is stored in the PrintShop Mail preferences and does

not need to be entered again. 

It is possible to place multiple PDF files into one PrintShop Mail

document.

Note that you cannot use encrypted, password-protected or

print-disabled PDF documents with PrintShop Mail.
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The PrintShop Mail User Interface

This chapter gives an overview of the PrintShop Mail user interface

and explains the contents of the various windows.

The General Toolbar

The general toolbar is placed in vertical position to the left of the

document window. This toolbar is always visible, even when no

document is opened. The table below displays the buttons on the

general toolbar and their function:

Button Function

Make a selection.

Place the insertion cursor to enter text.

Zoom in (or out when pressing the Option key).

Sample colors from objects.

Fill an object with a color.

Draw a text box.

Draw a picture box.
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The Document Window

Only one PrintShop Mail document can be opened at a time. The first

page of the document is shown in the document window. You can use

the commands in the Page menu to insert, delete or move pages and

to view another page.

The document window contains vertical and horizontal rulers, a

document toolbar, horizontal and vertical scroll bars, zoom and page

controls and a view of the current page of the document:
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Rulers

The horizontal and vertical rulers can be shown or hidden using the

“Show/Hide Layout Rulers” command in the “Windows” menu. The

measurement unit can be set in the Preferences. This unit will be used

throughout the PrintShop Mail program. 

The rulers are also used to place guides and folding lines on the

document. See “Displaying Guides on Your Document” on page 69

and “Adding a Folding Line” on page 128.

Zoom and page controls

The bottom left part of the document window contains a menu to set

the zoom factor, and buttons to move to the next or previous page of

the current document:

Click on the zoom factor to open a menu with available view sizes,

given in percentages of the original page size. When you select

“Window Size”, the entire page will be shown in the document window

and the zoom factor is adapted accordingly.

Moving to another page of the document is done by clicking on the

arrows next to the zoom factor, or by using the Document Layout

Window described further below.

previous page next page
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The Document Toolbar

The document toolbar is shown in the document window, immediately

below the horizontal ruler. The table below displays the symbols on the

document toolbar and their function:

Symbol Description

Section for the fill color and pattern settings.

Section for the border settings.

Section for the text settings.

Make object transparent.

Select color for text, borders or fill color.

Select line thickness.

Align text left.

Center text.

Align text right.
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The Database and Variables Windows

Both windows are essential while you use PrintShop Mail. You will

need them to link PrintShop Mail variables to database fields. See

“Linking Database Fields to Variables” on page 101.

The Variables Window 

Select “Show Variables” from the “Windows” menu to display the

Variables window. The variables window also contains a section for

“Layout Conditions” See page 131 for more details.

The Database Window 

Select “Show Database” from the “Windows” menu to display the

Database window.

Results of

Expressions or database fields
linked to PrintShop Mail variables

expressions
or contents
of database
fields

 

Variable
names

Contents of selected recordField 
names
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Other PrintShop Mail Windows

Apart from the Database and Variables windows described on the

previous page, you can choose other windows from the Windows

menu. A short description of their usage is given here:

The Fonts Window

This displays a list of the fonts used in the currently opened PrintShop

Mail document.

The Document Layout Window

This lists the pages in the current document and enables you to jump

to another page by clicking on it in the list. Also, page properties can

be set which determine the paper tray that is used when printing. The

Document window also contains buttons to add or delete pages. See

“Using the Document Layout Window” on page 59 for details.

The Coordinates Window

This window displays the coordinates of the selected page element

(an imported image or a Variable field) and allows precise positioning

and dimensioning of that page element by entering the coordinates

and sizes in the text boxes.
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Getting Started with PrintShop Mail

Tutorial: Creating the CatMetics Mailing

This chapter is meant for users who are not yet familiar with PrintShop

Mail. The step-by-step procedures described in this chapter will show

you how to use the main functions of the program.

The demo job used in this tutorial is one of the examples

available on the CD, so you can follow the steps explained

here in PrintShop Mail.

The tasks covered in this tutorial are:

Topic See

Create a New PrintShop Mail Document page 28

Import Static Elements into your Document page 29

Open a Database for your Document page 30

Create a Text Object for Variable Data page 32

Linking Database Fields to Variables page 36

Creating a Picture Object for Variable Graphics page 41

Formatting of Text Objects page 45

Printing the Mailing page 47

Creating Address Labels for the Mailing page 48
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Create a New PrintShop Mail Document

1 Double-click the PrintShop Mail icon to start the program.

2 Select “New” from the “File” menu. The following window pops up:

3 Adjust the settings, if necessary. If you select “Other” as paper

size, a new window pops up in which you can specify a custom

size. You can use either periods (.) or colons (,) as the thousands-

separator. In the Apple menu under “Control Panel - Numbers”

you can change the settings. Use the settings above for the tuto-

rial job.

4 Click “OK”. A new PrintShop Mail document is opened.

5 Select “Save As” from the “File” menu to save the document. 

The following window pops up:

6 Enter a file name for the tutorial job and click “Save”.

Portrait

Landscape
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Import Static Elements into your Document

1 Select “Place Image” from the “File” menu: 

2 Select the EPS file “CatMetics.eps” and Click “Open”. Note that

you can also use PDF files. To place a PDF file, use the command

“Place PDF” from the “File” menu (see page 62). After selecting

the example image, your document window should like this:
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3 You can move the imported image to the desired location, and

resize it if necessary by dragging the markers on its sides.

Open a Database for your Document

Textfile or DBF file

The variable texts and images that are printed in each copy of the

personalized document are determined by their calculation

expression. This links the variable text or image to fields in a database,

which can be either a textfile or a file in native database format (DBF).

Linking a Textfile to your Document

1 Select “Convert Text File...” from the “Database” menu to convert

a text file (e.g. “Catdata.tab”) to a dbf file (which will be saved as

“Catdata.tab.dbf”). The following window pops up:

2 Click the “Options...” button. In the dialog that pops up, you can

indicate the field separator (tab, comma, space, emicolon, or

user-specified) that is used in the textfile.

3 If you are using a database which was created on a DOS com-

puter, you may need to select a DOS conversion table. See

“Using a Text File as Database” on page 99 for details.
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4 Select “Catdata.tab” and click “Open”. The Database window is

opened and shows a list of available fields in the converted data-

base, with the values of those fields for the currently selected

record.

Linking a DBF file to your Document

If you have a database available in DBF format, you can open this

database instead of converting a text file. Note that you can only have

one database open at a time. You will have to close the current

database before opening another one.

1 Select “Open DBF-File” from the “Database” menu:

2 Select the database file “Catdata.DBF” and click “Open”. The

Database window is opened and shows a list of available fields in

the database, with the values of those fields for the currently

selected record.

Contents of the recordField
that is currently selected
in the Variables window

names
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Create a Text Object for Variable Data

There are different ways of entering variable text data into a PrintShop

Mail document. These are described separately below. Each of the

described methods is used at least once in the tutorial job.

Draw a Text Object and Drag Fields into it

1 Click  on the toolbar. See “The General Toolbar” on page 21

for detailed information about the toolbar.

2 Draw a text object where you wish to include the addressee’s

name and address at the top of the letter, as shown below.

To help you in positioning and sizing the text object, you

can use guides. See “Displaying Guides on Your

Document” on page 69 for details.
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3 Click on the field “First_name” in the “Database” window and drag

it into the text object. The fieldname will appear in the text object,

enclosed in @ signs and in the Variables window.

4 Select  from the toolbar and click in the text object, behind the

@First_Name@ variable. Enter a space. Then select the field

“Last_Name” in the fields window and drag it into the text object.

The variable @Last_Name@ is appended to the text and shown

as a separate variable in the Variables window.

5 After also dragging the “Address” fields into the text object (and

entering newline characters), your window should look like this: 
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Draw a Text Object and Type a Variable Name

1 Draw a text object as described above. For our example, create a

text object which covers the line “Dear Sir / Madam” in the Cat-

Metics letter.

2 Enter the text “Dear @First_Name@,” (without the quotes). The

variable “First_Name” is already listed in the Variables window,

and will receive the same value.

3 Click on the fill color selection button in the document toolbar and

select white as the fill color. This makes the text object cover the

line “Dear Sir / Madam” from the master document:

Do not forget to enclose each variable in @ signs. If you

want to use other symbols to enclose variables, you can

change this in the preferences. See “Modifying Desktop

Colors and Variable Markers” on page 86 for details.

4 If you enter a variable name that has not been used yet, it will

appear in the Variables window and have "" as its current expres-

sion. Changing expressions is described further below.
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Dragging a Database Field to the Document

If you want to create a text object which only contains one field from

the database, you do not need to draw a text object first and then enter

the field. Instead, follow the procedure below:

1 Make sure the area where you want to place the database field is

visible on the screen. For the example, we will put the contact

name below the letter, so you need to scroll the document down.

2 Click on the field “Contact” in the Fields window, drag it into the

document and drop it below the line “With kind regards,”. A text

object appears in your document with the text @Contact@ in it:

There is no difference between a text object created in this

way and any other text object. The text object can be

moved and resized and you can edit the contents at will.

The automatically chosen size of the object is set to fit the

field name, not the contents of that field in the database.
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Linking Database Fields to Variables

In PrintShop Mail, variable information is not immediately linked to

fields in the database. Through the use of expressions, the inclusion

of variable data in a personalized document is much more flexible than

a conventional mail-merge program allows. This paragraph shows

some of the possibilities of using expressions. Details are given in the

chapter “Working with Expressions in PrintShop Mail” on page 107.

Dragging Field Names to the Variables Window

1 If the Database and Variables windows are not visible yet, select

“Show Database” and “Show Variables” from the “Windows”

menu.

2 Select a database field in the Database window.

3 Drag the database field to the Variables window and drop it on the

variable that should be linked to the field. The fieldname will

replace the fieldname or expression shown in the “Calculation”

column of the Variables window.

When you drop a field on a variable that was already

linked, a dialog is shown, asking for confirmation before

the existing link is overwritten.
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Combining Multiple Fields in one Variable

A text object may contain multiple variables, each of which can be

linked to a database field by drag-and-drop (as described earlier). You

can also combine multiple database fields in one variable, with the

following procedure:

1 Select  from the toolbar and click in the text object that con-

tains the address. Replace the first line (with the @First_Name@

and @Last_Name@ variables on it) with @Name@.

2 Click outside the text object; the list of variables in the Variables

window is updated. The “Last_Name” variable has disappeared

and the “Name” variable is shown, with "" as its calculation.

3 Double-click on the “Name” variable in the “Variables” window.

This opens the Expression builder window for the variable:
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4 Double-click on the “First_Name” field in the list to the right. This

field name is now copied to the expression window in the top.

5 Click on the  button to add a & symbol to the expression. This

is used to concatenate strings in expressions. Instead of clicking

the button, you can also enter the & via the keyboard.

6 Click on the  button. Two quotes are added to the expression

and the textcursor is placed between them. Now enter a space

character. This will separate the contents from the “First_Name”

and “Last_Name” fields in the database.

7 Click behind the expression and add another + symbol.

8 Double-click on the “Last_Name” field in the list to the right. The

fieldname is added to the expression, which is now complete:
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9 You can click the Verify button to check for errors in the expres-

sion. If an error is found, the text cursor is moved to that location

and the type of error is indicated.

10 Click “OK” to assign the expression to the variable. The first part

of the expression is shown in the “Calculation” column and the

result for the currently selected record is shown to the right:

11 You can see the results of the expression for other records in the

database by clicking the arrow buttons shown next to the Result

column title.

Choosing between Alternative Texts

If the information stored in the database cannot be used exactly in the

variable text of your personalized mailing, you need to create an

expression which will create the required texts based on the available

information in the database. The following procedure shows how the

short names in the “Contact” field are translated to more user-friendly

versions in the CatMetics letter. To keep things simple, we assume

there are only two contact persons, Jenny and Bob.

1 Double-click the variable “Contact” in the “Variables” window to

open the Expression builder window for that variable.
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2 In the list of radio buttons to the left, click the one for “Logical”.

The list of available functions is filtered to only show functions

matching the selection criterion.

3 Double-click the IF( , , ) function in the function list. This is copied

to the expression, with the first function argument selected.

4 Double-click the “Contact” field in the fields list to the right. This is

copied into the first argument of the IF( ) function. To complete the

logical expression, add the text = “Jenny”.

5 Double-click the second function argument and type the name of

the first employee, enclosed in quotes: “Jenny Lap”.

6 Double-click the third function argument and type the name of the

second employee, enclosed in quotes: “Bob Tigerman”. Click OK

to accept the expression and close the window.
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Creating a Picture Object for Variable Graphics

1 Click  on the toolbar.

2 Draw a picture object where you wish to include variable graphics.

For the CatMetics example, draw a picture object just below the

contact name. This will be used to display a photograph of the

contact.

3 The variable used for the picture object is automatically named

“Picture 1” and appears in the Variables window. 

4 Double-click in the picture object to open a window where you can

edit the variable name and other settings. The next two subsec-

tions explain how to determine which images are shown in the

personalized copies of your document. Both methods are used in

the CatMetics example.
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Linking the Picture Object to a Database Field

1 Double-click the variable “Picture 1” in the “Variables” window.

This opens the window for the picture object that is drawn below

the contact and company name. In this picture object, a photo-

graph of the contact will be included.

2 Make sure that the Expression checkbox in the “Merge” section is

selected (this is the default for picture objects).

3 Check the “Scale (fit)” checkbox in the lower part of the settings

window. This makes sure the different photos will be made to fit

inside the picture object, regardless of their original sizes.

4 Close this window by clicking OK.

5 Double-click the variable “Picture 1” in the “Variables” window.

This opens the expression builder window, which allows you to

enter an expression that will determine which images are going to

be used for the picture object.
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6 Double-click the “Contact” field in the database fields list to copy it

into the expression.

7 Add the text & “.photo.eps” behind the closing bracket of the IF

function. This completes the expression for the picture object:

Using a Fixed List of Alternating Images

1 Create another picture object to the bottom right of the letter. The

object is automatically named “Picture 2”. Double-click the picture

object to open the settings window.

2 Click the radio button for Sequence (in the “Merge” section of the

window) and click the List button. 

3 A Merge List window opens. Click the “Add” button to choose an

image file. Once you select an image and click “Open” it is added

to the merge list. Choose “Add” again to add another image file.
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For the example, use the EPS images of cats which are available

in the CatMetics demo folder. For a list of supported graphic for-

mats, see “Supported Image File Formats” on page 141.

4 It is possible to repeat the same image for a number of consecu-

tive records, by editing the number indicated to the right of the list.

Double-click the line on which the image file is indicated and enter

the number of records you want to use the image for.

5 Cycling the list is done by checking the button “Cycle list”. The

other option is to repeat the last image for all remaining records.

6 Once you close the merge list and the settings window, the vari-

able “Picture 2” has disappeared from the Variables window, since

it is not linked through an expression anymore.
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Formatting of Text Objects

Changing the Text Style

Text style can be changed by selecting the text and then choosing one

of the commands in the Text menu. Note that one variable can only

have one style definition, i.e. if you want to use different styles, fonts,

sizes and/or text colors for two different variable parts of a text object,

you should create two variables and assign part of the text, and the

desired style properties, to each of them.

The following example shows how to create a colorful “Hello” message

which includes the name of the addressee’s cat (if this is available in

the database):

1 Create a text object below the “Picture 2” object.

2 Enter the text “Say hello to”. Press the Enter key to add a newline

and then enter the text “@TheCat@”.

3 Select the text object (click outside it and then in it again) and set

the alignment to Centered and the Size to 14 points.

4 Select  from the toolbar and select the variable @TheCat@

in the text object. Set the text Style to Bold and the Size to 18

points.
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5 Click the font color picker and select one of the available colors.

6 Now you can double-click the variable “TheCat” in the Variables

window and define its expression as follows: 

IF(Cat_name <>””, Cat_name, ”your cat”)

7 Choose the command Show Preview in the Windows menu. The

lower part of your CatMetics document should now look like is

shown here:
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Printing the Mailing

1 Choose the “Page Setup...” command in the “File” menu to make

sure that the page properties are set correctly for the printer you

are going to print the mailing on. Change the settings if needed.

You can save your own default values by pressing the ‘Alt’-key

and simultaneously clicking “OK”

2 Choose the “Print...” command in the “File” menu. PrintShop Mail

opens a dialog which allows you to set specific options:

3 Choose “All” if you want to print all records in the opened data-

base, or enter the desired range of records to the right.

4 If you do not want to print all pages in the document, you can

open a standard printer properties dialog by clicking the “Change”

button in the printer preferences section.

5 If you have a large database and you want to split printjobs, you

can check the option and specify the number of pages that should

be printed per printjob. See “Splitting Printjobs” on page 130 for

detailed information.
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Creating Address Labels for the Mailing

Address labels are usually much smaller than a printed page, and are

often printed on adhesive paper which contains multiple peel-off

labels. PrintShop Mail contains specific support for the printing of

multiple personalized documents per printed page. This section of the

tutorial describes the procedure, using an example that is also

available on the CD.

In the description below we use an EPS for the label, which has been

produced in QuarkXPress and is available on the CD. If you create

your own EPS image, make sure the document size for the EPS is set

such that it will fit on the label.

1 Create a new document. In the “Layout Setup” dialog that opens,

choose the “Other” option from the drop-down list and enter the

desired width and height for one address label, as shown. You can

use either periods (.) or colons (,) as the thousands-separator. In

the Apple menu under “Control Panel - Numbers” you can change

the settings.

2 After clicking OK, a new document will be shown in the PrintShop

Mail program window, with the specified size.
48 Getting Started with PrintShop Mail



3 If no database was open yet, open the “CatData.dbf” or import the

“CatData.tab” database. If you have just completed the previous

section of the tutorial, this database will still be open.

4 Save the document with the name “CatLabel.psm”.

5 Choose “Place image” Or “Place PDF” from the “File” menu and

select the file that contains the static elements needed on the

label. For the tutorial job, choose the file named “CatLabel.eps”. 

6 If the image is smaller than the chosen layout size, you may need

to move it to the desired location on the label.

7 Draw a text object to hold the addressee’s name and address 

8 Drag the database fields to the text object and enter the space

and newline characters where needed. See the description on

page 32 for details.
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9 Choose the “Show Preview” command from the “Windows” menu

to see what the result will look like. Browse through the database

by clicking the arrows in the top part of the variables window. The

label design for the tutorial should look like is shown here:

10 Check whether the “Page Setup” is correct for the printer and

paper you are going to use. The paper size determines how many

labels can be fitted on one printed page.
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11 Open the “Preferences” in the “Edit” menu and choose the section

titled “Print Order”. The following dialog is shown:

12 Specify the number of repetitions in horizontal and vertical direc-

tion. The number between brackets shows the maximum number

of prints that will fit on the page with the current layout size and

selected printer page size. Note that you need to press tab after

editing to make other controls in this dialog adjust to changes.

13 The priorities section determines in what order the copies of your

layout document will be placed on the pages. Choose a priority

from the pop-down list to the left. The next pop-down allows

reversing the ordering on that priority level. While you make

changes, the image to the right changes accordingly. See “Defin-

ing the Print Order” on page 88 for more details.

14 After you have finished the Print Order preferences, close the dia-

log and execute the “Print...” command from the “File” menu.
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Creating PrintShop Mail Documents

Introduction

This chapter covers all you need to know to create documents in

PrintShop Mail. The following topics are covered:

Topic See

How a PrintShop Mail Document Is Built Up page 54

Creating a New PrintShop Mail Document page 55

Opening an Existing PrintShop Mail Document page 57

Handling Pages in a PrintShop Mail Document page 58

Creating and Deleting Objects page 63

Manipulating Objects page 68

Formatting Objects page 75

Formatting the Contents of a Text Object page 79

Integrating Barcodes in PrintShop Mail page 83

Changing the PrintShop Mail Preferences page 85
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How a PrintShop Mail Document Is Built Up

Static Page Elements

The static page elements are normally created in applications like

QuarkXPress™, Aldus Freehand™, Adobe Illustrator™ or Adobe

Photoshop™. From these applications you create static images (in

EPS or other formats), which can then be imported to the PrintShop

Mail document using the “Place Image” command. If you have Adobe

Acrobat 4.0 or higher and at least 50 MBytes of memory available on

your Macintosh, you can also place PDF files.

Variable Page Elements

The variable page elements are defined as PrintShop Mail objects: the

text and picture objects you add from within the program. The variable

objects are bound to database fields and change contents with each

database record that is used.

Page Size and Printable Area

The page size for your document can be by selecting the “Layout

Setup” command in the File menu. To avoid that parts of objects are

positioned outside the printable area, select “Show Printable Area”

from the View menu. Thin blue lines appears next to the rulers at the

borders of your document. These lines surrounds the printable area,

in which all PrintShop Mail variables must be positioned.

Printable Area
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Details on the optional Bleed Margin, Crop Marks, and Folding Lines

are given in “Specifying a Bleed Margin and Cropmarks” on page 127.

Creating a New PrintShop Mail Document

1 Select “New” from the File menu. The following window pops up: 

2 Adjust the settings to your requirements. The table below shows

more information on the options in the Layout Setup window.You

can use either periods (.) or colons (,) as the thousands-separa-

tor. In the Apple menu under “Control Panel - Numbers” you can

change the settings.

Setting Description

Paper

Select a standard size for your PrintShop 
Mail document, i.e. A4, A3, B5, US Letter.
Select “Other” to enter customized 
settings.

Width
Enter custom width (enabled if you have 
selected “Other...” as a paper size).

Height
Enter custom height (enabled if you have 
selected “Other” as a paper size).

Orientation
Select either Landscape (lower button) or 
Portrait (upper button).

Portrait

Landscape
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You can adjust the Layout Setup settings at any time after

the document has been created, by selecting “Layout

Setup” from the “File” menu.

3 Click “OK”. A new PrintShop Mail document is opened.

4 Select “Save As...” from the “File” menu to save the document. 

The following window pops up:

5 Enter a distinctive file name, choose the folder where you want

the document to be placed, and click the “Save” button.
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Opening an Existing PrintShop Mail Document

1 You can only have one document opened at a time in PrintShop

Mail. If you want to open another document, first select “Close”

from the File Menu to close the currently opened document.

2 Select “Open...” from the “File” menu. The following window pops

up:

3 Select a PrintShop Mail document from the list and click “Open”.

The following window may pop up:

4 Click “OK”. Now the document will open. See “Using a Native

(DBF) Database” on page 97 to open the database manually, if

necessary.

5 If you are opening a document which you have recently worked

on, you may find it in the short list of recently opened documents,

which you will find in the “File” menu, in the “Open Recent” sub-

menu.
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Handling Pages in a PrintShop Mail Document

Inserting Pages

1 Choose the “Insert...” command from the “Layout” menu. 

2 Select the number of pages you want to insert, and indicate

where these pages should be inserted. Click “OK” to insert the

pages. The first of the inserted pages is shown on your layout.

Deleting Pages

1 Choose the “Remove Page(s)...” command from the “Layout”

menu.

2 Set the page numbers for the range of pages you want to remove

and click “OK”. All objects on the removed pages (the static and

variable objects) are lost.

3 Note that a PrintShop Mail document must contain at least one

page. Deleting the last remaining page is refused.
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Moving Pages

1 Choose the “Move...” command in the “Layout” menu. The follow-

ing window pops up:

2 Enter the range of pages you want to move and the destination of

those pages, then click “OK”.

Using the Document Layout Window

1 Open the Document Layout window by choosing the “Show Docu-

ment Layout” command in the “Windows” menu. The window

looks like is shown here:

The page properties (a page name and the paper tray that is used

when printing each page) are shown to the right of the page num-

ber.

2 To add a page, select the page after which you want to insert a

new page and click the add page symbol (shown to the right on

the bottom line of the window).

deleting a page

adding a page
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3 To delete a page, select the page in the Document Layout window

and press the Trashcan symbol. A confirmation dialog is shown

before the selected page is deleted.

4 To move a page, select the page in the Document Layout window

and drag it to another location. A small triangle to the left of the

window shows where the page will be placed when you release

the mousebutton.

5 To set or change the name for a page, double-click the page in the

Document Layout window. The following dialog pops up:

Enter the desired page name and click “OK”. The name is shown

in the Document Layout window, above the tray selection:

6 The options for tray selection depend on the used printer. The list

allows choosing a different tray per document page.

7 Close the Document Layout window by choosing the “Hide Docu-

ment Layout” command in the “Windows” menu or clicking the

close box in the Document Layout window.
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Placing EPS Images

1 Select “Place Image...” from the “File” menu. The following window

pops up:

2 Select the image file for the current page of your PrintShop Mail

document. Then click “Open”.

3 Move the image file to the desired location. If you want to resize

the image, drag its sides inward or outward (using the handles

shown when you select the image on the screen).

The use of single-character variables in EPS and other

files is also supported (these should be enclosed in @

signs, and they cannot be centered).

4 Repeat this step for all pages of your document with all the image

files that you want to place.

5 If the images are partly overlapping, you move them to different

levels by selecting one and choosing one of the commands in the

“Move” submenu in the Item menu.
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Placing PDF Images

1 Select “Place PDF...” from the “File” menu. 

2 When doing this for the first time, PrintShop Mail does not yet

know where Adobe Acrobat is located. A dialog is opened for you

to locate the program:

PrintShop Mail now places the PSMail plug-in for Acrobat in the

Acrobat Plug-ins folder and then starts the program. The next time

when you place a PDF, PrintShop Mail automatically starts Adobe

Acrobat in the background. The location of the program is stored

in the PSMail preferences.

3 Once Adobe Acrobat is started, you can select the PDF to open:

4 Move the image to the desired location on the page.
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Creating and Deleting Objects

Creating a Text Object

1 Click  on the toolbar.

2 Draw a text object where you wish to include variable text.

To display the tab ruler, select “Show Tab Ruler” from the

“Windows” menu. The ruler is only shown when you have

clicked in a text object.

3 Enter variable names between two @ signs:

You can combine the variables with ordinary text: all text that is

not enclosed in pairs of @ signs is printed on all copies of the

document, with the variables filled in according to their expres-

sions. For details on tab settings, see “Setting Tabs in a Text

Object” on page 80.
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4 Once you have entered the first variable and clicked outside the

text object, the Variables window pops up and displays all known

variable names:

5 Proceed similarly for all text objects you wish to include in the

document.

6 To change text, click  on the toolbar before clicking in a text

object (or double-click the text object). This switches to insert

mode. When clicking outside the text object, the program auto-

matically changes back to selection mode.

7 To view the contents of the Clipboard before pasting it into a text

object, you can select the “Show Clipboard” command from the

“Edit” menu. If a variable name is used more than once, the con-

tents of that variable change in all the text objects where they

have been used, according to the expression assigned to them

(which is shown in the Variables window).
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Creating a Picture Object

1 Click  on the toolbar.

2 Draw a picture object where you wish to include variable graphics.

The name “Picture 1” will appear in the Variables window.

3 Double-click the picture object. The settings window pops up:

4 Enter a distinctive name for the picture object, if necessary. The

name will automatically be adjusted in the Database window.
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5 Check the options needed from the “Fit to rectangle” group:

6 Click “OK”. For details on the “Merge” options, see “Creating a

Picture Object for Variable Graphics” on page 41.

Deleting an Object

1 Press  in the toolbar and select the object you wish to delete.

All variables defined for the object you are about to delete,

will disappear, including the expressions and other

settings you have defined for them.

2 Press the Backspace key or select “Clear” from the “Edit” menu.

Option Description

Clip
The imported graphic keeps its original 
size, but only the part visible in the picture 
object will be printed.

Scale (fit)

The imported graphic will be resized to 
the size that fits best inside the picture 
object, keeping its original aspect ratio. 
Part of the picture object may be empty.

Scale (fill)

The imported graphic will be resized to 
the size that fills the entire picture object, 
keeping its original aspect ratio. Part of 
the image may be clipped.

Center Image
The imported graphic will appear in the 
middle of the picture object.
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Getting Information on an Image

1 Select an image by clicking on it.

2 Select the “Information” command from the “Item” menu or dou-

ble-click on the image. If you have selected an EPS image, the

Static Image window pops up:

If you have select a picture object, the Variable Image window

pops up:
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Manipulating Objects

If you want to change the position and size of objects with great

precision, you can use the Coordinates window. Select the “Show

Coordinates” command from the Windows menu. Details are given in

“Using the Coordinates Window” on page 74.

Moving Objects

1 Select  from the toolbar and click on the object.

2 To select multiple objects, hold down the Shift key while you click

on each of them, or draw a box that encloses the objects. To

select all objects on the current page, choose “Select All” from the

“Edit” menu. Note that this also selects static images.

3 Position the cursor in the selected object. The cursor will change

into a small square with four arrows pointing outward.

4 Drag the object to its new position. Also see “Using the Guides to

Position Objects” on page 70.

If you want to move an object pixel by pixel, select it and

use the arrow keys, not the mouse, to move it.

Resizing Objects

1 Select  from the toolbar and click on the object. 

2 Handles will appear on the corners and in the middle of each side

of the object border. Move the cursor over one of the handles. The

cursor turns into a thin double-headed arrow.
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3 Click the handle and drag it to resize the object. Text will be

wrapped when it does not fit in the text object anymore. In this

case, a small square appears in the lower right corner of the text

object. Note that this only shows when the actual text does not fit

in the object, i.e. the square may show for some records but not

for others, as shown in the example below:

4 To check whether data from all records will fit in the text box, you

can use the layout check function, as described in “Checking your

PrintShop Mail Document” on page 125.

To return an image to its original size, select the image

and select “Original Size” from the “Item” menu.

Displaying Guides on Your Document

1 Select “Show Layout Rulers” from the “Windows” menu.

2 Select “Show Guides” from the “View” menu.

3 Click the arrows at the right-hand side of the top ruler and select

“Guides” from the pop-up menu:

4 For a vertical guide, click in the vertical ruler (at the left side of the

document window) and drag the mouse onto your document. For

a horizontal guide, click in the horizontal ruler (at the top of the

document window) and drag the mouse downward.
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5 A guide appears while you are dragging the mouse. Release the

mousebutton when you have reached the desired position for the

guide. 

6 The guides are shown as green lines on top of all visible elements

of the page (you can change the settings of the guides in the pref-

erences).

7 You can place multiple vertical and horizontal guides. Each page

has its own set of guides.

8 To remove a guide, place the mouse on top of it until the cursor

changes shape. Then drag the guide back to the vertical or hori-

zontal ruler.

Using the Guides to Position Objects

1 Select the “Snap to Guides” command in the “view” menu to make

the guides “magnetic”.

2 Select an object and move it towards a horizontal and/or vertical

guide. When releasing the object in the vicinity of the guide(s), the

object moves such that it aligns with the guide(s) exactly.

Guide
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3 To reduce or enlarge the “Magnetic strength” of the guides,

choose the “Preferences...” command in the “Edit” menu:

4 Change the number for “Magn. strength” in this dialog and click

“OK”. The indicated number of points is the distance from the

guide, within which an object will be drawn to the guide position.

Rotating Objects

1 Select the object you wish to rotate.

2 To select multiple objects, hold down the Shift key while you click

on each of them, or draw a box that encloses the objects. To

select all objects on the current page, choose “Select All” from the

“Edit” menu. Note that this also selects static images.

3 Open the “Rotate” submenu in the “Item” menu and select one of

the available options, i.e. 0˚, 90˚, 180˚ or 270˚. The object(s) and

the contents will be rotated clockwise over the chosen angle.
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Aligning Objects

1 Hold down the Shift key while you select the objects you wish to

align. Instead, you can also draw a box that encloses all objects

that need to be aligned.

2 Open the “Align” submenu in the “Item” menu.

3 Select one of the available options from the submenu:

Alignment option Description

Left Edges
To align the selected objects along their 
left edges.

Right Edges
To align the selected objects along their 
right edges.

Top Edges
To align the selected objects along their 
top edges.

Bottom Edges
To align the selected objects along their 
bottom edges.

Horizontal Centers
To align the selected objects along their 
horizontal centers.

Vertical Centers
To align the selected objects along their 
vertical centers.
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Moving Objects Forward or Backward

If object are (partly) overlapping, their ordering determines which

objects are printed on top of others. The objects are organized in

layers, from the back (printed on the page first) to the front (printed

last, i.e. on top of other objects).

1 Select  from the toolbar.

2 Select the object you wish to edit. Hold down the Shift key to

select more objects at a time.

3 Open the “Move” submenu in the “Item” menu and select one of

the available options. The commands in the submenu are:

Locking and Unlocking Objects

1 Select  from the toolbar.

2 Select the object(s) you wish to lock or unlock and choose the

“Lock” or “Unlock” command from the “Item” menu.

The handles of a locked object turn grey. Moving locked

objects is not possible, but you can still change the

contents (including its settings).

Option Description

To Front To place an object on top of all others.

Forward To move an object one layer forward.

Backward To move an object one layer backward.

To Bottom To place an object behind all others.
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Using the Coordinates Window

1 Select “Show Coordinates” from the “Windows” menu. 

The Coordinates window appears:

2 Select the unit of measurement you wish to use: mm, inches, cire-

ros, didots, picas or points.

The unit you select in the Coordinates window also

applies to the Layout and Tab Rulers, and to the unit of

measurement in the Preferences.

3 As you move or resize objects, the values in the Coordinates win-

dow are automatically updated. To set the position and size of

objects with great precision, you can edit the values (the values

are greyed and not editable when the object is locked):

4 Click “Apply” to confirm the adjusted settings or “Revert” to reject

the changes and return to the previous values.

Value Description

X shows the horizontal and Y the vertical 
position of the selected object. 0,0 is the 
top left corner.

W shows the width and H the height of 
the selected object.

∆h shows the change to the object’s 
horizontal position and ∆v the relative 
change to its vertical position while you 
are moving or resizing it.
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Formatting Objects

Restyling Object Borders

1 Select the object of which you want to restyle the borders.

2 Click  on the document toolbar. A menu pops

down, from which you can select the desired line

thickness. If you move the mouse outside the

area of the pop-down menu, the pop-down menu

is placed in a floating window, which stays open

and can be used to restyle object borders for

other objects.

3 If you select “Other...”, the following dialog appears:

Enter a custom line thickness and click “OK”.

Changing Object Colors

For variable text objects, colors can be chosen separately for the

background, the borders and the text. For variable images, only the

background and border colors can be chosen.

If you select colors when no objects are selected, you change

the default colors, which will be used when a new object is

created. The default colors are stored in the preferences and

used the next time you open PrintShop Mail.
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The procedure for changing object colors is the same for any of the

object elements that can be set. The buttons that open the color

palette or the color picker are repeated for the three different elements,

and are placed on the document toolbar, as shown:

Choosing Colors from the Color Palette

1 Select the object for which you want to choose the background,

border and/or text color. You can change the color for more than

one object at a time by selecting multiple objects while holding

down the Shift key.

2 Select a color from the Color Palette. Click the color indicator on

the document toolbar (in the fill section, the border section or the

text section). Select one of the colors in the color palette. 

3 If you move the mouse outside the color palette area, it is

detached from the toolbar and becomes a floating window. The

title bar shows for which element the color palette is used. This

window stays open until you click its close box.

4 You can redefine a color in the color palette by double-clicking the

color. This opens the Color Picker, which is described in the fol-

lowing paragraph. Once you have defined the color, it replaces

the selected color in the color palette.

5 Since the same color palette is used for all three elements, the

same color is changed in all color palettes equally.

color palette
color picker

background border text
76 Creating PrintShop Mail Documents



Defining Colors in the Color Picker

1 Select the object for which you want to choose the background,

border and/or text color.

2 Click the current color indicator in the document toolbar for the

element you want to change (background, border or text). The

Color Picker window pops up:

3 Select a color by clicking in the color disc or entering the values in

the edit boxes to the right. The brightness can be changed by

dragging the scrollbar below the color disc. Click “OK” to set the

color.
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Overprint and Knockout

Applying Overprint to Objects

Overprint is used to show the background through the text object.

1 Select an object containing variable data. In this example, the text

color is yellow and the background is cyan:

2 Select “Overprint” from the “Item” menu. The yellow text blends

with the cyan background and the printed result will be green:

The blending of background and foreground cannot be

made visible on the screen, so the green color will not be

shown, even when “Show Preview” is selected.

Applying Knockout to Objects

Knockout is used to hide the background image behind the object.

1 Select the object.

2 Select “Knockout” from the “Item” menu. The object will be printed

exactly as shown on the screen, regardless of the background. In

the above example, the text “Koozbaine” will appear in yellow.
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Formatting the Contents of a Text Object

Entering Text and Variables into a Text Object

1 Select “Show Invisible characters” from the “Windows” menu to

display the text symbols.

2 Select  from the toolbar and click in the text object.

3 Start typing text and variables.

Variables must be enclosed in @ signs, e.g. @Name@,

and may consist of 30 characters at the most.

Aligning the Text in a Text Object

1 Position the cursor in the text object.

2 Click the appropriate button on the document toolbar or select a

command from the “Align” submenu in the “Text” menu.

Toolbar Align menu Description

Left To align text left in text object.

Centered To center text in text object.

Right To align text right in text object.

Justified
To apply justified alignment to 
the text in the text object
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Setting Tabs in a Text Object

1 Position the cursor in the text object.

2 Select “Show Tab Ruler” from the Windows menu. The tab ruler

will appear immediately above the selected text object:

3 Click the Tab selector in the top of the ruler and choose the tab

type from the pop-down menu. The “Right Margin” type is

described further below. 

4 Click in the bottom part of the ruler at the position(s) where you

want to place a tab. The appropriate tab symbol is placed at the

chosen position(s).

Editing Tab Settings in a Text Object

1 Click on a tab position on the text ruler. The Tab Settings window

pops up:

Left margin
and indent

Tab selector

Right margin

Tab positions
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2 Adjust any settings in the Tab Settings window:

Note that you can simply drag the tab to another position

on the text ruler to alter its position.

3 Click “Apply” to get a preview.

4 Click “OK” to accept or “Cancel” to reject the changes.

Remove a tab position by simply dragging the arrow off

the text ruler. The upper part of the text ruler displays the

message “delete”.

Indenting Text in a Text Object

1 Select the lines of text to be indented.

2 Drag the indent marker to the desired position on the text ruler.

3 Drag the right margin to the desired position on the text ruler.

Note that the right margin marker determines where word

wrapping is done when text lines are too long to fit in the

text object.

Setting Description

Alignment Select another alignment option for the tab.

Position Enter another position for the tab.

Left margin
and indent

Tab selector

Right margin

Tab positions
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Defining Leading between Text Lines

1 Select the lines in a text object between which you want to adjust

the leading.

2 Select “Leading” from the “Text” menu. The following window pops

up:

3 Select one of the available settings:

Defining Text Font, Text Style and Text Size

1 Select the text in a text object. You can apply different fonts, styles

and sizes to different portions of text in the same text object.

2 Select the text and apply the desired font, size and style from the

“Font”, “Size” and “Style” submenus in the “Text” menu.

You can only apply one font, style and size to a variable

text: if you select part of a variable name and apply text

formatting, the format will be discarded or applied to the

entire variable text.

Setting Description

Automatic To apply a default leading based on font and size.

Fixed To apply a customized leading in points.
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Integrating Barcodes in PrintShop Mail

Detailed information on barcode functions is given in the Appendix,

which contains the current list of available barcode generators.

1 Draw a text object and enter a variable name, e.g. @Barcode@.

2 Double-click the chosen variable name in the Variables window.

The Expression window pops up. 

3 Click the radio button titled “Barcode” to display all barcode gener-

ators, and select the required function from the list. A barcode

function translates a numerical code to a text string, which yields

the desired barcode when printed with a special barcode font.

4 As the argument to the barcode function, enter the database field

that contains the code that should be translated into a barcode.

Some barcode functions require another argument. For details on
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the available barcode generators and the required arguments,

see the Appendix. Also, you may want to check the technical doc-

umentation of the barcode readers you are going to use.

5 Select the variable and pick the barcode font, that is specified for

use with the chosen barcode generator, from the fonts list in the

“Text” menu. Adjust the font size to show the barcode at the spec-

ified or desired size. Use the “Show Preview” in the “Windows”

menu to see the result on your screen.

Examples of EAN8 and UPCA barcodes:

Item
digit

Check
digit

4 0 6 7 8 0 8 5

Item
digit

ID
digit

Producer
digit

Check
digit

0 1 2 3 0 0 7 0 3 2 1 5
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Changing the PrintShop Mail Preferences

The various preferences for PrintShop Mail can be changed through

the “Preferences” command in the “Edit” menu. This command opens

a dialog window, in which the preferences are grouped. The pages can

be opened by clicking the appropriate icon in the preferences group list

to the left of the window.

Icon Description Page

Program:
Variable markers, measurement 
units, colors for guides, magnetic 
strength

86

Printer:
Move print, report page, specific 
options for printing technologies

87

Print order:
Number of prints per page, ordering 
and positioning (also double-sided)

88

Impositioning:
Bleed margin size and position, crop 
marks, folding lines

90

Numerator:
Settings for the built-in COUNTER 
function that is used to add serial 
numbers to copies of documents

91

Pictures:
Location of variable images, 
maximum preview size per image

92

Date format:
Format string and language for dates 
generated by the DATE function

93
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Modifying Desktop Colors and Variable Markers

The appearance of generic elements in the document window can be

adapted to your individual wishes.

1 Select the “Program” section in the “Preferences” dialog:

2 Specify different variable markers, if necessary.

3 Change colors by double-clicking the color boxes and choosing a

new color from the color picker:

Item Description

Printable Area
Area in which all variable objects must be 
positioned.

Guides Guides help you position objects.

Bleed margin Margin intended for cropmarks.

Folding lines
Folding lines are meant for finishing 
purposes.
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Setting the Printer Preferences

PrintShop Mail supports a wide range of printing technologies. In some

printer types, special functions are supported which can be used from

within PrintShop Mail. See “Supported Print Technologies” on

page 142 for details.

1 Select the “Printer” section in the “Preferences” dialog:

2 If you need to move the printed page along the horizontal or verti-

cal axis, you can enter the pointsizes in the ∆h and ∆v boxes.

3 In the Printing Technology section you can choose the printer type

from the pop-down list. If specific options are available, they will

be shown in this part of the window.

4 In the bottom section you can specify whether a report page

should be printed after each printjob. Also, you can send a sepa-

rate report page (e.g. to send or fax to Atlas Software when

requesting support) to the printer immediately by choosing “Print

Report Page” from the “File” menu”.
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Defining the Print Order

If you want to print more than one document (e.g. an address label or

business card) per page, you need to specify the repetition size and

printing order.

1 Select the “Printorder” section in the “Preferences” dialog:

2 Specify the number of repetitions in horizontal and vertical direc-

tion. The number between brackets shows the maximum number

of prints that will fit on the page with the current layout size and

selected printer page size. 

Note that you need to press tab after editing to make other

controls in this dialog adjust to changes.

3 If the labels should not be printed immediately next to each other,

you should indicate the spacing between labels in horizontal

and/or vertical direction.
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4 The priorities section determines in what order the copies of your

layout document will be placed on the pages. Choose a priority

from the pop-down list to the left. The next pop-down list gives the

option to reverse the ordering on that priority level. While you

make changes to the priorities and ordering, the image to the right

changes accordingly..

5 The “Double sided layout” option enables you to match front and

back of records when printing double-sided. This option only

works if your layout document has two pages (front and back). If

you select this option, the record numbers used for the front and

backside of the page are matched. Also, the position of the labels

on the backside is mirrored from the frontside. The result is shown

in this example:
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Adding Bleed Margin, Crop Marks and Folding Lines

For post-processing of printjobs, various options need to be set and

markers need to be printed on the pages.

1 Select the “Impositioning” section in the Preferences dialog:

2 Choose the option for the Bleed margin: None, Add to Job or

Include in Job. When added to the job, the indicated size is added

to all sides of the chosen paper size, i.e. the size of the printed

pages increases. When included in the job, the bleed margin is

subtracted from the chosen paper size on all sides.

3 Choose the option for crop marks and specify the gap size. This is

only possible when you have defined a Bleed margin.

4 If you want to use folding lines, select the folding lines option and

set the overlay length. See “Adding a Folding Line” on page 128

for details on how to use folding lines.
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Defining the Counter Characteristics

PrintShop Mail contains a COUNTER function, which can be used to

serialize documents independent of a database record. The settings

for this COUNTER function are defined in the Preferences.

1 Select the “Numerator” section in the “Preferences” dialog:

2 Select the start value and the step size for the counter.

3 If you want the same number to be printed more than once before

the counter value is incremented, you should specify the number

of repetitions.

4 Specify the number of digits to be printed. If you always want the

same number of digits to be used, even in small numbers (“001”

instead of “1”), you should check the “Leading Zeroes” option.

5 The “number of items without database” option allows you to seri-

alize documents without access to database records.
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Locating Variable Images

Variable images allow personalizing your documents with pictures,

which need to be located in specific folders.

1 Select the “Pictures” section in the “Preferences” dialog:

2 Indicate whether the variable images are located in the database

folder or elsewhere.

3 If you choose “Other”, you need to specify the folder by clicking

the “Edit...” button. The chosen folder is indicated below the folder

selection options. If you want subfolders to be used, check the

“Search subfolders” option.
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Specifying the Date Format

The specified date format is the default format in date functions in the

Expression builder.

1 Select the “Date format” section in the “Preferences” dialog:

2 Select a format from the drop-down menu.

3 If you choose “Other…” the following window appears:
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Working with Databases in PrintShop Mail

Introduction

This chapter explains how to link variable page elements in a

PrintShop Mail document to database fields. The following topics are

discussed:

Topic See

Names not to use as Database Fields page 96

Using a Native (DBF) Database page 97

Using an ODBC Connection page 98

Using a Text File as Database page 99

Linking Database Fields to Variables page 101

Filtering Database Records page 102

Sorting the Database page 106
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Names not to use as Database Fields

Keywords

Some words must not be used as field names in your database. They

are keywords reserved for the expression parser:

• AND

• OR

• NOT

• TRUE

• FALSE

Function Calls

Expressions may contain functions and database field names. To

keep these apart, you should avoid using function names as database

fields. If a database field name is the same as one of the functions in

PrintShop Mail, the database fieldname will get an underscore

appended to it. Refer to “Working with Expressions in PrintShop Mail”

on page 107 for further information on expressions, functions and

arguments.
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Using a Native (DBF) Database

Using an Excel© or Claris™ FileMaker Database

The following rules apply to a file in native database format, i.e. DBF,

if you want to link it to a PrintShop Mail document:

• The first line in your database should contain the field names.

• Field names should only contain alphanumeric characters and 

underscores, and have a maximum length of 10 characters.

• The variable data should be listed below the first line.

• Variable data items should not contain quotes.

• The database file should be saved as a DBF3 or DBF4 file. 

In Claris FileMaker, you have to export the file to DBF format.

• The filename should have the ending ".dbf" (not dbf3 or dbf4).

Storing Image References in a Database

The following rules apply to variable image references in database

files: 

• The variable images referred to in the database should have the 

same name as the image files you are going to use.

• The image files referred to should be located in the same folder 

as the database file.

Opening a Native Database File in PrintShop Mail

1 To avoid problems with special characters (e.g. ë, å, ç, etc.) that

may be stored in the database, you should select the correct set-

tings from the “DOS Table” submenu in the Database menu.
Working with Databases in PrintShop Mail 97



2 Select “Open DBF-File...” from the "Database" menu. The follow-

ing window pops up:

3 Select the desired database file and click the “Open” button. All

field names of the database file appear in the Database window.

Opening Another Database

1 Select “Close” from the "Database" menu to close the currently

opened database. It is not possible to have more than one data-

base file open at the same time.

2 Open another database through the “Open DBF-File...” command.

The newly opened database file should at least contain

the fieldnames you have used in expressions, to prevent

errors when printing the document. Of course, you can

also change the expressions to fit the new fieldnames.

Using an ODBC Connection

To open an ODBC connection, an ODBC driver needs to be installed

on your Macintosh. The command “Open ODBC-connection...” in the

"Database" menu is automatically enabled in that case. For

information about how to handle the ODBC connection, see the

documentation that should be supplied with your ODBC driver.
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Using a Text File as Database

The following rules apply when using a text file as database:

• The first line in your text file should contain the fieldnames.

• The fieldnames may only contain alphanumeric characters and 

the underscore. 

• The variable records should be listed on the following lines.

• The field separator is either a tab, a comma, a space, a semicolon 

or a user-defined character (not alphanumeric or underscore) and 

cannot be used in field contents.

• If a field contains a field separator character, it should be 

enclosed in double quotes in order to be treated as one string.

• Two adjacent field separators imply that an empty field is placed 

between them.

• The record separator is a newline character.

• Any missing fields at the end of a line are left empty.

Opening a Text File as Database

1 Select “Convert Text File...” from the "Database" menu. The follow-

ing window pops up:
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2 Click the “Options...” button. The following window pops up:

3 Select the character that is used as a separator in the text file and

click the “OK” button.

If you click "Other", the edit box next to that option is

enabled. The most common used separators are tabs and

commas.

4 Select a text database file and click “Open...”. The Database win-

dow pops up:

5 Select the appropriate command from the “DOS-table” submenu

in the "Database" menu. The selected table is used when convert-

ing a DOS text database to DBF format.

Contents of record
that is currently selected
in the Variables window

Field names
100 Working with Databases in PrintShop Mail



Linking Database Fields to Variables

1 Select “Show Database” and “Show Variables” from the "Win-

dows" menu.

2 Select a database field in the Database window.

3 Drag the field to the Variables window.

4 Drop the database field on the PrintShop Mail variable you wish to

link it to. The first variable of the database file appears in the

Result column of the Variables window. You can scroll through the

variable data by clicking the arrows, or entering the desired record

number and pressing the return key.

When you drop a database field on a variable that was

already linked, you will be asked for confirmation before the

link is overwritten.

Instead of dragging a database field to the variables window and

dropping it on a variable, you can also drop the database field on the

document. A new PrintShop Mail variable will be created with the

same name as the database field. This variable will appear in the

variables window, with the database field in its calculation column.
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Filtering Database Records

PrintShop Mail allows you to filter the database to which you wish to

link your document. This implies that only a selection of the database

records is going to be used, e.g. only the records with Gender "f”.

Defining a Filter for the Database

1 Open the “Database” window and click the “Edit” button next to

the “Filter” checkbox. The "Database-filter" window pops up:

2 Enter an expression of which the result can only be true or false.

3 Select “Filter” from the Database menu or click the “Filter” check-

box in the Database window to apply your filter settings. Selecting

and deselecting the filter option toggles between using the entire

database or using only the filtered records. The filter option is

enabled only when a database is currently opened.
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Storing and Retrieving Filter Favorites

If you are using the same filters for different PrintShop Mail documents

or for different databases, you may want to store the filter definitions in

the favorites. When you have filter expressions stored in the favorites,

you can reuse them without having to create them again every time

you need them. The filter expressions are stored in a file named “Filter

favorites“, which is stored in the folder where the PrintShop Mail

application program is also stored.

1 To store a filter expression (or part of it) in the filter favorites, open

the Database Filter window (as shown in the previous paragraph)

and create the filter expression.

2 Click on the “Favorites” tab. The expression will remain visible,

and the favorites section of the Database Filter window is shown:

3 Click on “New” to store the current expression as a favorite.

List of
Favorites

Expression

Selected
Favorite

Current
Definition
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4 The new favorite will be listed in the favorites list to the left, and

the name and expression of the currently selected favorite are

shown to the right.

5 The name of a new favorite is automatically generated, but may

be changed in the “Name” field to the right.

6 If you want to change the expression that is stored in a favorite,

you can edit the expression in the window to the right and click

“Save”. As long as you have not saved the changes yet, you can

click “Revert” to return to the previously saved version.

Note that several favorites in the list may have the same

name. This does not cause any problems for PrintShop

Mail, but it may be useful to choose distinctive names.

7 To remove a favorite from the favorites list, select it in the list and

click “Remove”.

8 To retrieve a favorite and use it in the filter expression, make sure

the text cursor in the expression window is at the right position

and double-click the favorite in the favorites list. The expression is

now inserted in the filter expression window.

9 The filter expression can still be edited, and you can change to

the “Components” tab of the Database Filter window without los-

ing any information. When you have finished creating the filter

expression, press “OK” to activate the filter.
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Importing Filter Favorites

Filter favorites are stored in a file named “Filter favorites” in the folder

where the PrintShop Mail program is also stored. If you have filter

favorites defined in earlier versions of the program, you can import

these by opening the old Filter favorites file in the new version of

PrintShop Mail. There are different ways of doing this:

1 Double-click the "Filter favorites" file in the Finder. If the PrintShop

Mail application is not running yet, it will be opened. If the applica-

tion was already running, it is activated.

2 Drag the "Filter favorites" file icon onto the PrintShop Mail applica-

tion icon. If the PrintShop Mail application is not running yet, it will

be opened. If the application was already running, it is activated.

3 If you have not opened a PrintShop Mail document yet, you can

use the “Open...” command in the "File" menu to open the "Filter

favorites" file. Since no PrintShop Mail document is opened, no

document window will appear and the “Open...” command in the

"File" menu remains enabled.

The favorites from the opened file will be added to the already defined

filter favorites, and stored in the Filter favorites file of the PrintShop

Mail application when you quit the program.

Note that, after importing, several favorites in the list may

have the same name. This does not cause any problems for

PrintShop Mail, but it may be more useful to change some of

the names to make them distinguishable.
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Sorting the Database

You can define a large number of sort keys, which are applied to the

opened database. Defining the sort keys and their precedence is done

independently of switching sorting on or off, as explained below.

1 Open the "Database" window and click the "Edit" button next to

the "Sort" checkbox. The "Sort Records" window pops up:

2 Select a database field in the list to the left and press the “Add”

button to copy it to the Sort Order list to the right. Double-clicking

the field name has the same effect. Repeat this with all the fields

that you want to use as further sort keys.

3 You can specify the sort order per selected field, which is either

Ascending or Descending by selecting a sort key in the list to the

right and dragging it up or down, or remove a sort key by selecting

it and clicking “Clear” (or double-clicking the sort key).

4 Press “Sort” to sort the database and “Ready” to close the dialog . 

5 You can switch between sorting and not sorting the database by

checking or unchecking the “Sort” option in the Database window
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Working with Expressions in PrintShop Mail

Expressions and Data Types

An expression is a combination of database field names, numbers,

character strings, functions and operators. Expressions are defined for

variable text and variable image elements. When printing a PrintShop

Mail document, the expressions are solved for each of the selected

records in the database, and the resulting texts or images are printed.

Database fields, functions and expressions can be classified into one

of the following data types:

The functions defined in PrintShop Mail require parameters in specific

data types. Conversion between data types is possible. The data types

returned by the functions of PrintShop Mail are determined by the

function group to which they belong. See “Function Arguments” on

page 108 for a description of the arguments and return data types.

Data type Description

Character data All keyboard characters not used in calculations.

Numeric data
Numbers, decimal points and plus or minus signs 
used in calculations.

Logical data Data indicating a value that is “true” or “false”.
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Function Groups and Data Types

The table below lists all function groups with the functions belonging

to that group and the return data types:

Function Arguments

Arguments are a symbolic representation of the type of information a

particular function requires. Each function in the following chapters is

followed by the arguments it needs to obtain a result. Arguments must

be separated by commas. The table below gives an overview of the

arguments used in the following chapters:

Group Functions Return

String
CHR, LEFT, LOWER, LTRIM, MID, 
PROPER, RIGHT, RTRIM, STR, 
TRIM, UPPER

character 
strings

Number
ABS, ASC, COUNTER, 
CCOUNTER, INT, LEN, MOD, POS, 
ROUND, SGN, VAL

number 
values

Date DATE, TODAY date string

Barcode
CODE39, CODE128, EAN13, EAN8, 
ITF, POSTNET, UPCA, UPCE

barcodes

Logical AND, IF, NOT, OR true or false

Argument Description

<C>, <C1>, <C2> Expressions of type “Character data”

<N>, <N1>, <N2> Expressions of type “Numeric data”

<L>, <L1>, <L2> Expressions of type “Logical data”

<D> Date format string
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Date Format Strings

The table below lists the characters used in a date format string:

If the date format expression is an empty string Date(""), the

date format is determined by the settings in the “Date Format”

section of the "Preferences". See “Specifying the Date

Format” on page 93 for details.

Capital Description Example

D Day number 2

DD Day number with leading zero 02

DDD Abbreviated day name Mon

DDDD Full day name Monday

M Month number 9, 11

MM Month number with leading zero 09

MMM Abbreviated month name Sept

MMMM Full month name September

YY or Y Abbreviated year number 99

YYYY or YYY Full year number 1999
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Defining an Expression for a Variable

1 Double-click the variable in the Variables window for which you

want to define an expression. The Expression window pops up:

2 Choose the type of function by clicking one of the function group

buttons to the left. The functions in that group are listed in alpha-

betical order.

When you click a function once, the function name and

the arguments to be used are shown.

3 Double-click a function to insert it into the expression. It is

inserted at the point where the text cursor is placed.

4 Select operators from the keypad, where needed. Click once to

insert them at the current position of the text cursor.

Database
Function

Operators

fields
groups

Functions

Expression

Syntax

Example
Help text
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5 Select database fields from the list to the right. Double-clicking

the field inserts it into the expression at the current text cursor

position.

Operators

The table below gives an overview of the operators that can be used

in expressions:

Operator category Operator Description

Logical operators

( ) Groups expressions

NOT Logical negative

AND Logical AND

OR Logical inclusive OR

Arithmetic operators

* Multiplication

/ Division

+ Addition

- Subtraction

Relational operators

< Less than

> Greater than

= Equal to

<> Not equal to

<= Less than or equal to

>= Greater than or equal to

String operator
+
¶

Concatenate strings
Return
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Using Favorites in Expressions

To help creating expressions, a list of favorites is maintained, from

which you can enter complete expressions by double-clicking. You

add favorites and insert them in the current expression from the

"Favorites" section in the Expression window, as shown here:

Click "New..." to enter a new favorite. The current expression is

entered into the definition window to the right. You can edit the name

and the definition before saving the favorite. To remove a favorite from

the list, select the favorite and click "Remove".

To enter a favorite into the expression, double-click it in the list to the

left. The favorite is entered at the current position of the text cursor.

You can edit the expression and enter more than one favorite. The

expression remains the same when switching between the

"Components" and "Favorites" sections of the "Expression" window.

List of
Favorites

Expression

Selected
Favorite

Current
Calculation
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Importing Expression Favorites

Expression favorites are stored in a file named “Expression favorites”

in the folder where the PrintShop Mail program is also stored. If you

have expression favorites defined in earlier versions of the program,

you can import these by opening the old Expression favorites file in the

new version of PrintShop Mail. There are different ways of doing this:

1 Double-click the "Expression favorites" file in the Finder. If the

PrintShop Mail application is not running yet, it will be opened. If

the application was already running, it is activated.

2 Drag the "Expression favorites" file icon onto the PrintShop Mail

application icon. If the PrintShop Mail application is not running

yet, it will be opened. If the application was already running, it is

activated.

3 If you have not opened a PrintShop Mail document yet, you can

use the “Open...” command in the "File" menu to open the

"Expression favorites" file. Since no PrintShop Mail document is

opened, no document window will appear and the “Open...” com-

mand in the "File" menu remains enabled.

The favorites from the opened file will be added to the already defined

expression favorites, and stored in the "Expression favorites" file of the

PrintShop Mail application when you quit the program.

Note that, after importing, several favorites in the list may

have the same name. This does not cause any problems for

PrintShop Mail, but it may be more useful to change some of

the names to make them distinguishable.
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Alphabetical list of Functions

Barcode functions are listed in the Appendix.

ABS( <N> )

ABS returns the absolute value of <N>.

ABS(-25) = 25

ASC( <C> )

ASC translates the first character in <C> into its ASCII value.

ASC("A") = 65

ASC("Alpha") = 65

CCOUNTER( <N1>, <N2>, <N3>, <N4>, <C> )

CCOUNTER returns a counter value determined by the arguments:

<N1> is the start value for the counter

<N2> is the end value for the counter (inclusive)

<N3> is the step value (the value that is added with each count)

<N4> is the number of digits for the counter value

<C> is the fill character that should be used

If the end value is reached before the last record is printed, the counter

starts again, as shown in the second example:

CCOUNTER(5, 100, 2, 3, "0") = 005, 007, 009, ...

CCOUNTER(1, 6, 2, 1, "") = 1, 3, 5, 1, 3, 5 ...
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CHR( <N> )

CHR translates the ASCII value <N> into a character.

CHR(65) = A

COUNTER( )

COUNTER returns the current value of the numerator. The settings for

the numerator are defined in the Preferences dialog. See “Defining the

Counter Characteristics” on page 91.

COUNTER( ) = 0001

COUNTER( ) = 0002

DATE( <C1>, <C2> )

DATE can be used to customize date formats. DATE takes the date

represented in <C1> and returns it reformatted according to the date

format string <C2>. If <C2> is empty, the date formatting is determined

by the settings in the Preferences.

DATE("19990607", "") = 6/7/99

DATE("19990607", "MM/DD/YY") = 06/07/99

DATE("19990607", "DDD, MMM D, YYYY") = Mon, Jun 7, 1999

DATE("19990607", "MMMM D, YYYY") = June 7, 1999

DATE("19990607", "anno domini YYYY") = anno domini 1999

IF( <L>, <expr1>, <expr2> )

IF returns the value represented in <expr1> if the logical expression

<L> is true; if <L> is false, the value represented in <expr2> is

returned. The expressions used for <expr1> and <expr2> must be of

the same type. The result from the IF function is converted to a string.

IF(1>2, "Right", "Wrong") = Wrong
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INT( <N> )

INT returns the integer part of a numeric expression.

INT("123.45678") = 123

LEFT( <C>, <N> )

LEFT returns a string containing the <N> leftmost characters in the

character string <C>. If <N> is larger than the length of <C>, the

complete string <C> will be returned. If <N> is less than or equal to

zero, an empty string is returned.

Note that text in an expression must be enclosed in double quotes,

otherwise it will be interpreted as a database field.

LEFT("PrintShop Mail", 5) = Print

LEFT(Gender, 3) = fem

LEN( <C> )

LEN returns the length of the character string <C>.

LEN("PrintShop Mail") = 14

LEN(First_Name) = 5

LOWER( <C> )

LOWER converts all letters in the string <C> to lowercase.

LOWER("PrintShop Mail") = printshop mail
116 Working with Expressions in PrintShop Mail



LTRIM( <C> )

LTRIM removes all leading spaces from the string <C>. Using this

function you can remove the space after a database field when that

field is empty, as shown in this example:

LTRIM(Gender & " ") & LTRIM(First_name & " ") & Last_name

MID( <C>, <N1>, <N2> )

MID returns a section of the string <C>, starting at character position

<N1> and with length <N2>. The string <C> starts at position 0.

MID("PrintShop Mail", 6, 4) = Shop

MOD( <N1>, <N2> )

MOD returns the remainder resulting when dividing <N1> by <N2>.

MOD(7, 3) = 1

MOD(2, 3) = 2

POS( <C1>, <C2>, <N> )

POS searches for the substring <C2> in <C1> and returns the starting

position of <C2> within <C1>. With the number <N> you can specify

the character position in <C1>, where POS should start looking for the

substring <C2>.

POS("proprietory", "pr", 1) = 1

POS("proprietory", "pr", 2) = 4

PROPER( <C> )

PROPER converts the first character of every word in string <C> to

uppercase and all other characters to lowercase.
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PROPER("pRintsHOP MAIL") = Printshop Mail

PROPER("Atlas software BV") = Atlas Software Bv

RIGHT( <C>, <N> )

RIGHT returns a string containing the <N> rightmost characters in the

character string <C>. If <N> is larger than the length of <C>, the

complete string <C> will be returned. If <N> is less than or equal to

zero, an empty string is returned.

Note that text in an expression must be enclosed in double quotes,

otherwise it will be interpreted as a database field.

RIGHT("PrintShop Mail", 4) = Mail

RIGHT(Address3, 3) = nia

ROUND( <N> )

ROUND rounds the number <N> to an integer value (no decimals).

ROUND(123.456) = 123

ROUND(123.5) = 124

RTRIM( <C> )

RTRIM removes all trailing spaces from the string <C>.

RTRIM("PrintShop ") = PrintShop

SGN( <N> )

SGN indicates whether the result of <N> is positive or negative.

SGN(-100) = -1

SGN(0) = 0

SGN(100) = 1
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STR( <N> )

STR converts the numeric expression <N> into a character string.

STR(5*2) = 10

TODAY( <D> )

TODAY returns the current system date, formatted according to the

date format string <D>.If the string is empty, the data formatting is

determined by the settings in the Preferences.

TODAY("") = 6/7/99

TODAY("MM/DD/YY") = 06/07/99

TODAY("MMMM DD, YYYY") = June 07, 1999

TRIM( <C> )

TRIM removes all leading and trailing spaces in the string <C>.

TRIM(" PrintShop ") = "PrintShop"

UPPER( <C> )

UPPER converts all characters in the string <C> to uppercase.

UPPER("PrintShop Mail") = PRINTSHOP MAIL

VAL( <C> )

VAL converts the character expression <C> into a number.

VAL("99") = 99
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Examples of Using Expressions

Placing "Mr." or "Mrs." before the Name

You may want to open your letter with "Dear Mr. Smith," or "Dear Mrs.

Jones". If you have a database field containing the addressee’s

gender, you can achieve this effect by using this expression:

"Dear " & IF(Gender = "m", "Mr. ", "Mrs. ") &

Last_name & ","

To avoid mistakes when the gender is not available (or written with

capitals), you may want to extend the expression as follows:

"Dear " & IF(LOWER(Gender)="m","Mr.",

IF(LOWER(Gender)="f","Mrs.","Mr./Mrs."))

& Last_Name & ","

Note the inclusion of spaces behind most strings in the above

examples; this saves having to add separate spaces to separate these

strings from field contents.

In the CatMetics example, the placed EPS image already contains the

phrase "Dear Mr./Mrs.,". Instead of changing the original layout

document, you can put a variable text object on top of the phrase,

choose the "Knockout" mode from the Item menu, and apply the

desired background color to the object (white in this case). In this way,

the original phrase is hidden behind the newly created text object.
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Building a Special Counter

To add a serial number to your documents, you can use either the

COUNTER or the CCOUNTER function. The settings for the COUNTER function

are defined in the Preferences (see “Defining the Counter

Characteristics” on page 91). The following example uses the

CCOUNTER function to build a more complicated counter, consisting of a

character and a digit, with the aim to create the sequence:

A1 - A2 - A3 - A4 - B1 - B2 - B3 - B4 - C1 - …

The counter actually consist of two CCOUNTER functions which are

concatenated. The first one is the more complicated one, since it

should yield letters rather than numbers. The CCOUNTER needs to be

initialized at the ASCII value for "A" and use four steps to increment

the value to the next ASCII value. This is achieved by the following

expression:

CCOUNTER(ASC("A"), ASC("Z"), 1/4, 2, "")

Note that the number of digits is two, since this function call results in

ASCII numbers, which take two digits in the range "A" to "Z". The

option for leading zeroes is not important in this case. Since the

function returns a string rather than a number, and we need the ASCII

number to convert it to the letter, we need to use two conversions:

CHR(VAL(CCOUNTER(ASC("A"), ASC("Z"), 1/4, 2, "")))

Then the result needs to be concatenated with a simple counter which

runs from 1 to 4 repeatedly, as shown in the full expression:

CHR(VAL(CCOUNTER(ASC("A"), ASC("Z"), 1/4, 2, ""))) 

& CCOUNTER(1, 4, 1, 1, "")
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Assigning a Color to a Variable Depending on Its Value

You can assign a text color to a variable text object depending on its

value, e.g. to write negative numbers in red and positive in black. To

achieve this result, you need to define two adjacent variables in the

same text object, and assign the different colors to them. As a

suggestion, you could call them @Red@ and @Black@.

Then you assign the expression for the variables as follows:

@Red@: IF(Number < "0" ,Number ,"")

@Black@: IF(Number < "0" ,"" ,Number)

Using a Database Field for a Picture Object

The CatMetics example contains pictures of cats of different races.

Also, the database contains the race of the addressee’s cat (in most

cases this field is filled in). This makes it easy to add a picture of the

addressee’s cat (or at least a very similar cat) to the mailing, using a

safety construction for records that do not contain a race indication:

IF(Catrace = "", "Domestic",Catrace) & ".eps"

The images "Domestic.eps", "Siamese.eps" etc. must either be

available in the database folder, or in the folder that is indicated in the

Preferences for variable images. See “Locating Variable Images” on

page 92 for details.
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Comparing Dates in a Conditional Expression

In the CatMetics example we have also included a personal note to the

addressee, which uses a date-dependent expression to either say

hello to the addressee’s cat, or congratulate the addressees on their

cat’s birthday. The latter is only printed if the mailing is printed in the

month of the cat’s birthday.

IF(DATE(Birthday,"M")=TODAY("M"),"Congratulations on " 

& IF(Cat_name<>"",Cat_name,"your cat") & "'s birthday",

"Say hello to "& IF(Cat_name<>"",Cat_name,"your cat")) 

The first line contains the comparison of dates. The data string in the

database and the date returned by TODAY are reformatted to only

include the month. If the months are equal , the birthday message is

printed. Otherwise, the phrase is replaced by "Say hello to …". In both

cases, the cat’s name is used when available in the database.
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Printing PrintShop Mail Documents

Checking your PrintShop Mail Document

Displaying the Font Usage

You can check which fonts are used in your document (and whether

all used fonts are available on your Macintosh) by selecting “Show

Fonts” from the "Windows" menu. The Fonts window will pop up:

• Fonts available on your system are check-marked.

• The other fonts still have to be installed on your system.

Performing a Layout Check

When printing a document, PrintShop Mail checks the layout before

the document is sent to the printer. The layout check detects errors

and displays them in a so-called "pre-flight" window. You can also

perform a layout check independent of printing. In that case, you can

determine which checks need to be performed.

1 Choose the "Layout Control" in the "layout" menu
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2 In the dialog window that opens, select the types of checks you

want to perform and click "Verify":

If errors are found in this so-called "pre-flight" process, a window

opens with the error messages:

Click on a message to see where the error is located.
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Specifying a Bleed Margin and Cropmarks

Cropmarks are used when further finishing needs to be done on the

printed documents. If the paper size is not the same as is used in the

printer, crop marks need to be set to allow exact positioning of cutting

devices. The bleed margin is used to allow the printable area to cover

the entire page (after it has been cut to the desired size).

1 Choose the "Preferences..." command in the "Edit" menu and

select the “Impositioning” section in the Preferences dialog:

2 Specify the width of the bleed margin, i.e. an extra margin espe-

cially meant for cropmarks. If you set the bleed margin to "Add to

Job", the paper used in your printer should be larger. Choose

"Include in Job" if you want to subtract the bleed margin from the

printed document.

3 Check the “Cropmarks” option and specify the Gap size, i.e. the

distance between the cropmark and the edge of the document.
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Adding or Removing Folding Lines

Folding lines are printed on the visible part of the document (the part

that will remain when the document is cut to the right size, i.e. they are

also printed when there is no bleed margin). They are printed on either

side of the document, and on all pages.

Adding a Folding Line

1 Select "Show Layout Rulers" from the Windows menu.

2 Click the arrows at the right-hand side of the top ruler.

3 Select "Folding Lines" from the pop-up menu.

4 For a vertical folding line, click in the vertical ruler (at the left side

of the document window) and drag the mouse onto your docu-

ment. For a horizontal folding line, click in the horizontal ruler (at

the top of the document window) and drag the mouse downward.

5 The folding line appears while you are dragging the mouse.

Release the mousebutton when you have reached the desired

position for the folding line.

6 To remove a folding line, place the mouse on top of it until the cur-

sor changes shape. Then drag the folding line back to the vertical

or horizontal ruler.

7 In the Preferences window, you can set the length of the folding

lines. This is the length of the folding lines as they will appear on

the final document (after it has been cut to size).
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Specifying the Page Setup

1 Select the correct printer driver in the "Chooser". See “Configur-

ing the LaserWriter Driver” on page 13.

2 Select “Page Setup” from the "File" menu. The Page Setup win-

dow pops up, showing the current settings: 

3 Select the paper size from the paper drop-down menu.

4 If you need a non-standard paper format, choose "Custom" and

click on the page image to enter the exact width and height.

You can change the unit (“cm” or “in”) to specify paper

size and margins by simply clicking on the paper image.

5 Select the layout for your document by selecting an option from

the layout drop-down menu.And specify a scaling factor and page

orientation.

6 You can save your own default values by pressing the ‘Alt’-key

and simultaneously clicking ‘OK
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Splitting Printjobs

When printing documents from PrintShop Mail, you have the option of

splitting the printjob into smaller jobs. This is described below.

1 Choose the “Print” command from the “File” menu:

2 Check the option “Split job every” option and enter the number of

pages for each job.

3 If you are printing a multipage document, the split job size should

be dividable by the number of pages in the document. If this is not

the case, a dialog will appear allowing you to round the split job

size to a multitude of the number of pages in the document:

4 Select one of the offered choices and click "OK".
130 Printing PrintShop Mail Documents



Layout Conditions

Layout conditions enable you to skip or blank out certain pages from a

multipage document, depending on variables in your database. The

layout conditions are listed in a separate section of the "Variables"

window. To open this window with the correct tab shown, choose the

"Show Layout Conditions" command from the "Windows" menu.

Each layout represents one page in the master document and has

exactly one expression, which determines whether the page should be

printed, blanked out or skipped. Blanked out pages result in a page

being passed through the printer without anything printed on it.

The expression for each layout is built in the same way as expressions

for variable items (see “Linking Database Fields to Variables” on

page 101), but the result should be PRINT, SKIP or BLANK. Invalid

expressions will not be accepted. The default expression for each

layout is PRINT (as shown for layout 1 in the above example).

Fiery FreeForm, Splash DiamondMerge and PrintStreamer

do not support Layout Conditioning, because these

technologies are based on a so-called master document. The

master document demands a constant number of pages per

record, so the expression ‘SKIP’ cannot be used. 
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Example: Gender-Specific Layouts

Imagine a fashion shop producing a mailing to announce their new

summer collection. Following the generic first page, they want to

include a different second page with offers for men and women. Also,

for customers who live outside the immediate area, they include a

special page that contains a lunch voucher.

Their database of regular customers contains gender information,

which can now be used to print the correct second page for each of

their customers. Both layouts are added to the same document, but

they are skipped or printed according to the gender ("M" or "F") found

in each individual record. If no gender is found, both pages are printed.

The last page, which contains the lunch voucher, is skipped if the

customer lives in the same city. The layout conditions for this example

would look like shown here:
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Using SKIP with Layout Repetition

If you are using layout repetition to print multiple documents on each

page (“Creating Address Labels for the Mailing” on page 48), you

should be aware that using the SKIP expression may change the

sequence of records on the page. In some cases, PrintShop Mail will

treat the SKIP as a BLANK to avoid problems with automated cutting

and sorting. 

Using multipage layouts with layout repetition and layout conditions

should be thorougly tested before running large printjobs.

Similar problems may occur with full-page layouts, when the input for

the printer is organized in a specific manner (e.g. one page with

preprinted company letterhead followed by two blank pages). When a

layout is skipped in the printout, no paper is used for that layout and

the sequence is influenced.

If you want to keep the sequence of printed records but still want to

avoid printing layouts with invalid data, you should use BLANK instead

of SKIP. This will use the same space as a PRINT, without actually

printing anything in that space.
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Print Record

Open the dialog under the menu option "File - Print Record" This

command prints the current open file with the current record, without

printing the text "PrintShop Mail" across the middle of the page. This

doesn’t cost any credits.

PPML

PPML is short for Personalized Printing Markup Language. This is a

standard defined by manufacturers of printers and printing software,

allowing personalized printing to become more flexible, easier to use

and more affordable to produce. A PPML file describes the entire

personalized printing job and contains all necessary elements to print

the contents (layouts and selected variable data).

Producing a PPML file in PrintShop Mail 4.3 is done by selecting the

"Export to PPML" command in the "File" menu. This makes a dialog

window appear, allowing you to set options for the PPML that will be

produced.
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Image Options

Include local images

This causes the image references to be stored as local references

(relative to the location of the layout description). When the PPML

file is transported to another computer before being printed, the

images are searched locally on that computer. This will reduce the

size of the PPML file. 

Note that the images should be available on the computer

from which the printjob is started. This may be used when

the PPML was produced and transported earlier and

changes have been made which do not affect the images.

Copy local images

This causes copies of all used images to be placed in the same

folder where the PPML file is created. This option is useful when

producing a PPML for the first time, or when changes in the layout

affect the used images.

Export to PPML Zip

This option is used for specific printers, which expect a PPML-Zip

file. The file contains the PPML file and all image files, so you can

be sure that all necessary files are available.

None

In this case, no images will be copied but all references include the

marker "http". This option can be used if you can be sure that the

computer on which the printjob will be executed has network

access to the computer on which the images are located.
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Using the Open PrePress Interface

PrintShop Mail supports the Open PrePress Interface (OPI) version

2.0. This allows the user to link low resolution images in the layout of

PSMail documents and have the OPI server replace these with high

resolution images when printing. This feature yields an even faster

spool and print speed when high resolution variable images are used.

In the "File - Print" dialog you can mark the checkbox to use OPI, as

shown below:

Note that, when using the CreoScitex VPS print technology,

the "Use OPI" option is replaced by "Use APR". APR is the

"Automatic Picture Replacement" solution that is available in

CreoScitex VPS systems. For all practical matters, APR is

equivalent to OPI. See “CreoScitex VPS” on page 145.
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Using the HotFolder

PrintShop Mail 4.3 allows you to automate the printing process to a

high extent. Instead of opening a document in PrintShop Mail and

selecting the "Print" command, the program can be told to monitor a

so-called HotFolder and execute printjobs as soon as the necessary

ingredients (a PrintShop Mail document and a database file) are found

there.

This feature can be used to allow more than one user to "drop" their

database files into the HotFolder, causing a printjob to start without

further interaction (and without even needing access to the PrintShop

Mail program from their computers).

Initializing the HotFolder

1 Close all PrintShop Mail documents but don’t exit the program.

2 Open the Preferences and select the options group "HotFolder":
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3 Select the HotFolder by opening a Browse dialog and locating the

desired folder.

4 With all PrintShop Mail documents closed, choose the "Monitor

HotFolder" command from the "File menu.

5 To stop the monitoring and automatic printing of the document,

click on the "Cancel" button.

Using the HotFolder

1 Create the PrintShop Mail document and store it in the HotFolder.

Since there will not be any user interaction with the program when

the document is automatically printed, you should check the

design and verify the expressions used in it thoroughly before

saving the document.

2 Drop a database file (with extension "DBF") into the HotFolder.

Within 30 seconds, PrintShop Mail combines the database with

the available PrintShop Mail document and starts the printjob. In

addition to the HotFolder itself, three levels of subfolders can be

used to drop database files in. This may be useful if multiple users

want to produce mailings with different database files.
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3 After PrintShop Mail has printed the document, the database file

is moved to a folder "PSMAIL_PRINTED", which is created next

to the HotFolder. The PrintShop Mail document remains in the

same location and can be used again (by simply dropping another

database file into the HotFolder).

4 PrintShop Mail writes a log of its actions into a logfile. Since the

timestamp of the logfile is automatically adjusted everytime when

PrintShop Mail becomes active, this timestamp can be used to

check whether PrintShop Mail is still running or not. If no data-

base file was found (and no printjob was started), the logfile is still

updated. The logfile is located in the folder, in which the HotFolder

is also placed.
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Appendix

Supported Image File Formats

PrintShop Mail uses QuickTime (version 4.0 or higher) to handle

image files. The supported image file formats therefore depend on the

version of QuickTime you have installed on your Macintosh. For a list

of supported image file formats you should visit Apple’s QuickTime

website.

QuickTime version 5.2 supports QuickDraw PICT, QuickTime Image,

MacPaint, Photoshop (versions 2.5 and 3.0), GIF, JPEG, TIFF, Amiga

IFF, PCX, Pixar, Scitex CT and Targa.
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Supported Print Technologies

CopyPage

This option uses the PostScript CopyPage command to prevent the

master page from being rerastered with every copy. Using this

technology limits you to printing one personalized document page per

printjob. Also, the use of transparent objects is not supported.

Standard PostScript

This option does not use any special mechanism to optimize process

time. It is meant for systems that do not support any of the other

options.

Optimized PostScript

This option uses the PostScript Level 2 (Forms) technology to reach a

shorter process time. It works on virtually all printers but the speed

depends on the complexity of the printed document.
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The Cache size affects the caching of the RIP. A larger cache size may

increase performance, but uses more printer memory.

Fiery FreeForm

This option is available on Fiery ZX RIPs from EFI. 

These RIPs use a two-step process. First, you print one single record

with the Master option set. Then the Variables are printed, using the

same form number as you specified when printing the Master. This

allows you to keep different Masters in the RIP’s memory.

Instead of using the two steps, you can also choose to print Master and

Variables in one go, by choosing the “All” option in the print dialog, as

shown here:
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Fiery FreeForm 2

This new printing technology is available on Fiery ZX RIP’s from EFI.

It is a two-step process. First, set the option to "Print Master" and print

one record. This uses no credits. Then set the option to "Print

Variables" and print the desired records. It will use the design of the

master document printed before. This allows a high speed in RIP-ing

the document. Fiery FreeForm 2 supports “Layout Conditions” (see

page 131), and you can also see which masters have been sent to the

RIP.

PrintStreamer

This printing technology sends two separate files to the RIP, one

master file and one with variable data.
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CreoScitex VPS

This option is available on a Scitex SX3000. It makes use of the

variable data system that is built into these RIPs.

This technology includes a number of subset finishing options (such as

stapling and binding) that become available in a separate dialog that

is shown when printing a document.

One further option for this printing technology is Automatic Picture

Replacement (APR). This is basically the same as the OPI technique

that is used with other printers (as described on page 136). Image files

are sent to the RIP separately; when the print job is started, only the

references to the images are spooled.

The APR option is switched on or off in the print settings dialog that

opens when selecting the “Print” command from the “File” menu.
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Splash DiamondMerge

This is the technology used on DocuPress Ultra systems from Splash.

It requires the same two-step process as is used for Fiery FreeForm.

Use the Create Master option to print the master page and use the

same form number when printing the variable page elements (with the

option Use Master Settings.

The print options are very similar to the ones for Fiery FreeForm.

Splash VI

This is the Variable Information solution by Splash. Use this option if

you have a Splash system different from the DocuPress Ultra (which

uses the DiamondMerge technology).
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AHT

This is the variable data printing solution built into AHT printers.
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Barcode Generators

PrintShop Mail supports printing barcodes, as explained in “Integrating

Barcodes in PrintShop Mail” on page 83. PrintShop Mail 4.3 comes

with barcode fonts, which are automatically installed with the product.

Printing the string in the correct barcode font gives the desired result.

The currently available barcode generators are listed below.

CODABAR ( <C1>,<C2>,<C3>,<C4> )

The <C1> should consist of numeric characters (no alphabetic

characters) of variable length. The start character <C2> can be

a,b,c,d,t,n,*,e. The stop character <C3> can be the same as the start

character. If this character is not entered, this function will take the

start character also for stop character. The <C4> parameter is a

boolean to indicate if you want a check digit (TRUE) or not (FALSE).

The check digit is a result of the modulus 16 operation applied to the

value in <C1>.

CODE39 ( <C1>, <C2> )

This barcode allows all ASCII characters (including special characters)

to be encoded, using two control sequences to indicate the start and

end of the special characters. The value to be encoded is expected in

<C1>; the <C2> parameter is a boolean that indicates whether a check

digit should be added (TRUE) or not (FALSE).

CODE128 ( <C>)

This barcode allows the full ASCII character set (128 characters) to be

coded in a format that includes two built-in checks.
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EAN8( <C> )

EAN8 prints the variable barcode represented in the code string <C>

according to the EAN8 standard, which expects a 7-digit numeric

code. The 8th digit is added as a control value. The supplied string

<C> should be the string representation of the numeric code. If less

than 7 characters are provided, leading zeroes will be added. Any

characters following the 7th are truncated.

EAN13( <C> )

EAN13 prints the variable barcode represented in the code string <C>

according to the EAN13 standard, which expects a 12-digit numeric

code. The 13th digit is added as a control value. The supplied string

<C> should be the string representation of the numeric code. If less

than 12 characters are provided, leading zeroes will be added. Any

characters following the 12th are truncated.

ITF ( <C1>, <C2> )

ITF belongs to the 2/5 barcodes family. The decimal digits are coded

in 5 bits; the first four are meaningful in the order 1, 2, 4 and 7. The fifth

bit is an even parity bit. The digit "0" and the start/stop character are

exceptions to this rule. The ITF function converts a string to a valid

“Interleaved Two of Five” code. Text should only contain digits. The

<C2> parameter is a boolean to indicate if you want a check digit

(TRUE) or not (FALSE).

MSI ( <C> )

MSI converts the number <C> (13 digits maximum) into an MSI Plessy

barcode, which includes a modulus 10 check digit. 
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belongs to the 2/5 barcodes family. The decimal digits are coded in 5

bits; the first four are meaningful in the order 1, 2, 4 and 7. The fifth bit

is an even parity bit. The digit "0" and the start/stop character are

exceptions to this rule. The ITF function converts a string to a valid

“Interleaved Two of Five” code. Text should only contain digits. The

<C2> parameter is a boolean to indicate if you want a check digit

(TRUE) or not (FALSE).

POSTNET ( <C> )

The POSTal Numeric Encoding Technique was developed by the

Postal service to encode ZIP-code information on letters for rapid and

reliable sorting by barcode readers. The POSTNET code can

represent a 5-digit ZIP-code, a 9-digit ZIP+4 code or an 11-digit

delivery point code.

POSTNET11 ( <C1>, <C2> )

The POSTal Numeric Encoding Technique was developed by the

Postal service to encode ZIP-code information on letters for rapid and

reliable sorting by barcode readers. The POSTNET11 takes a 9-digit

zipcode (e.g. “1234-5678”) and adds the last 2 digits of a primary

street address or other delivery point address to yield a valid 11-digit

delivery point code.

UPCA( <C1>, <C2> )

UPC-A prints the variable barcode according to the UPC-A standard,

which expects a 10-digit numeric code represented in the string <C1>

and a separate system number <C2>. If <C1> contains less than 10

characters, leading zeroes are added. All digits following the 10th are

truncated.
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UPCE ( <C> )

UPC-E is obtained from the UPC-A version by omitting some zeroes

from the code (“zero suppressing”). Only the system numbers 0 and 1

are available, and the first is currently in use. The UPC-E coding table

differs from the UPC-A version because of the even parity coding

which is reserved with respect to the coding of UPC-A. The data field

consists of 6 characters: 3 with even coding and 3 with odd coding.

The number system and the check digit are not explicitly present in the

UPC symbol but derived from the particular combination of parities in

the coding of the 6 meaningful characters.
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